# Table of Contents

Overview ........................................................................................................................................ 3  
Prerequisites .................................................................................................................................. 3  
MySQL Installation & Configuration ............................................................................................... 3  
  Downloads ..................................................................................................................................... 3  
  MySQL Community Server ............................................................................................................ 3  
  MySQL Workbench ....................................................................................................................... 4  
MySQL Installation (Windows) ........................................................................................................ 5  
MySQL Workbench Installation (Windows) ....................................................................................... 16  
Configure MySQL Workbench for your MySQL Server (Windows) ............................................... 19  
Appendix A ..................................................................................................................................... 33  
  .NET Installation .......................................................................................................................... 33  
Appendix B ..................................................................................................................................... 35  
  Microsoft Visual C++ Redistributable Package .......................................................................... 35  
Appendix C ..................................................................................................................................... 36  
  Installation Configuration Files ...................................................................................................... 36  
    my.ini configuration file (Windows) ............................................................................................ 36  
    my.cnf configuration file (Linux) ............................................................................................... 36  
Appendix D ..................................................................................................................................... 37  
  Collation Settings ......................................................................................................................... 37  
Appendix E ..................................................................................................................................... 38  
  Linux Installation .......................................................................................................................... 38  
  Post Installation on Linux ............................................................................................................ 38  
  Create a remote server ................................................................................................................. 40
Overview
This document will provide guidelines installing and configuring MySQL for use with the Apelon DTS server. Examples given throughout the document reflect a windows installation. For Linux instructions see Appendix E.

Prerequisites
.NET 2.0 or higher
For instructions to install .NET on Windows 2008R2 refer to Appendix A

Microsoft Visual C++ 2010 Redistributable Package (x86) (vcredist_x86)
For additional information Refer to Appendix B

MySQL Installation & Configuration

Downloads

MySQL Community Server
Download the current available version of the MySQL Community Edition.

http://www.mysql.com/downloads/mysql

For Windows, choose one of the following, depending on the bit size of your OS configuration. Example below:

Windows (x86, 32-bit), MSI
Windows (x86, 64-bit), MSI

After selecting your download option you will be prompted to enter your user/email/company information.
**MySQL Workbench**


Select the following download link

**MySQL Workbench 5.2.35**

Select Platform:

```
Microsoft Windows  Select
```

<table>
<thead>
<tr>
<th>Platform</th>
<th>Version</th>
<th>Size</th>
<th>Download</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows (x86, 32-bit), MST Installer</td>
<td>5.2.35</td>
<td>25.9M</td>
<td><a href="http://www.mysql.com/downloads/workbench/">Download</a></td>
</tr>
</tbody>
</table>

**Select a Mirror to Start Downloading - mysql-workbench-gpl-5.2.35-win32.msi**

You are downloading:

`mysql-workbench-gpl-5.2.35-win32.msi`

To make this download faster, please choose a mirror site close to you from the list below.

**Mirrors in: United States**

- Hurricane Electric / San Jose, CA [HTTP](http://www.mysql.com/downloads/workbench/)
- pair Networks / Pittsburgh, PA [HTTP](http://www.mysql.com/downloads/workbench/)
- University of Wisconsin / Madison, WI [HTTP FTP](http://www.mysql.com/downloads/workbench/)
- Argonne National Laboratory / Chicago, IL [FTP](http://www.mysql.com/downloads/workbench/)
- Hooby Classifieds / Chicago, IL [HTTP](http://www.mysql.com/downloads/workbench/)
MySQL Guidelines for DTS

**MySQL Installation (Windows)**

Navigate to the folder you downloaded the install to and execute the mysql install package.

<table>
<thead>
<tr>
<th>Name</th>
<th>Date modified</th>
<th>Type</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>mysql-5.5.12-win32</td>
<td>5/17/2011 7:39 PM</td>
<td>Windows Installer ...</td>
<td>28,288 KB</td>
</tr>
<tr>
<td>mysql-workbench-gpl-5.2.33-win32</td>
<td>5/18/2011 10:00 AM</td>
<td>Windows Installer ...</td>
<td>25,819 KB</td>
</tr>
</tbody>
</table>

Click Run

![Open File - Security Warning](image)

Click Next

![MySQL Server 5.5 Setup](image)
Accept the terms and click Next.

Select Complete

Choose Setup Type

- **Typical**: Installs the most common program features. Recommended for most users.
- **Custom**: Allows users to choose which program features will be installed and where they will be installed. Recommended for advanced users.
- **Complete**: All program features will be installed. Requires the most disk space.
Click Install

Click Install to begin the installation. Click Back to review or change any of your installation settings. Click Cancel to exit the wizard.

Installing MySQL Server 5.5

Please wait while the Setup Wizard installs MySQL Server 5.5.

Status:

Back  Install  Next  Cancel
Click Next >

Leave “Launch the MySQL Instance Configuration Wizard” and Click Finish
When the MySQL Instance Configuration Wizard starts, click Next.

Select “Detailed Configuration” and click Next.
Select the Server Configuration that best fits your needs and click Next. Note the differences:

Select “Developer Machine” if the server will be used for testing/development and installing/using the Workbench on the same machine.

Select “Dedicated MySQL Server Machine” if the server will be used for production and you will be installing/using the Workbench on a remote machine.
Select “Transactional Database Only” and click Next.

Select the drive and path for the InnoDB tablespace and click Next.
Select Decision Support (DSS)/OLAP or choose Manual Setting and number of users if more than 20 concurrent connections are needed. Click Next.

Select both (default) options:
   Enable TCP/IP Networking
   Enable Strict Mode

Click Next.
Select “Best Support for Multilingualism” (UTF8) then click Next.

For additional information regarding the configuration files see Appendix C. Select both options:

- Install As Windows Service
- Include Bin Directory in Windows Path

Click Next.
Enter a new root password, confirm the password and click Next.

*Note: The default username is root, make sure you record the Root Password*

Click Execute to configure your database server, when complete click Finish.
Note: If you receive any error messages during the installation process cancel the install, go to 'Control Panel' and remove MySQL. Before reinstalling MySQL, close all programs, restart the machine turn off Antivirus and reinstall.

DELETE C:\ProgramData\MySQL This is a hidden directory and if you do not see it you will need to go into your folder options and show hidden files and folders.

Be sure to restart after uninstalling and deleting the folders.

If problem persists, try downloading the current development release again and reinstall.

Help can also be found at http://www.mysql.com/
MySQL Workbench Installation (Windows)

Navigate to the folder you downloaded the install to and execute the mysql workbench install package.

The MySQL Workbench Setup wizard will open, click Next.

Select Complete and click Next.
Select Complete and click Next.

Click Install
Click Next.

Leave “Launch MySQL Workbench” checked and click Finish.
Configure MySQL Workbench for your MySQL Server (Windows)

Launch MySQL Workbench for the first time.

Click Server Administration > New Server Instance to register the new server instance
Enter in the correct parameters to connect to the server.

Set the connection values.
Test your connection and click Next.

Specify your operating system and click Next.
Test settings and click Next.

Review Parameters and click Next.
Create Instance Profile and click Finish.

You should now see the server instance you created.
Click on Server Administration above the server you just created. You will get this popup. Choose your server and click OK.

A new tab appears in your application.
Click the Configuration > Options File > Networking Tab.

Set max_allowed_packet to 100M (checkbox activates field for edit) and click Apply button at bottom to write changes to my.ini configuration file.

Under Security click on Users and Privileges
Click Add Account button in bottom left and enter your user information.

Example:

- Login Name = dts
- Leave “Limit Connectivity to Hosts Matching = %
- Password = dts
- Confirm Password = dts
- Click Apply

<table>
<thead>
<tr>
<th>Login</th>
<th>Administrative Roles</th>
<th>Account Limits</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>You may create multiple accounts with the ability to connect from different hosts.</td>
</tr>
<tr>
<td>Login Name:</td>
<td>dts</td>
<td></td>
</tr>
<tr>
<td>Limit Connectivity to Hosts Matching:</td>
<td>%</td>
<td>% and _ wildcards may be used</td>
</tr>
<tr>
<td>Password:</td>
<td>***</td>
<td>Type a password to reset it.</td>
</tr>
<tr>
<td>Confirm Password:</td>
<td>***</td>
<td>Enter password again to confirm.</td>
</tr>
</tbody>
</table>

X out of the current admin tab and click on the home tab.

From the home screen, double click on the newly created connection.
In the left panel, right click SCHEMAS and select “Create Schema”

Name your schema (e.g. DTS) and select your default Collation: utf8_general_ci and click Apply.
Review the SQL Script to be applied and click Apply.

After the script is successfully applied, click Finish.
It will state that the changes have been applied, click Close.

For additional information about collation settings, see Appendix D.

Go to the Home Tab, under Server Administration; double click the entry you created.
Under SECURITY select Users and Privileges
Select DTS from User Accounts
Select the Administrative Roles Tab
Select the following roles:
- MonitorAdmin
- DBManager
- DBDesigner
- BackupAdmin

Click Apply
Click on the Schema Privileges tab
Select user (e.g. dts)
Select Add Entry

Select DTS as your schema and click OK.
Click the Select “ALL” button and check the GRANT OPTION then click Save Changes.

**Note:** To create a connection test queries into the DTS database with the SQL Editor as the user you created, click on the Home tab and click New Connection to create a new DB connection. Specify the connection settings and click the Test Connection button to make sure you can login as the user.
Appendix A

.NET Installation

Install the .NET Windows Server 2008 R2

From the Server Manager Window Select Features and an Add Features window will appear.

Select .Net Feature and click Next

Click Install
Click Close

After installing it is recommended to perform your Windows Updates.
Appendix B

Microsoft Visual C++ Redistributable Package

For Windows (x86, 32-bit), systems:

Accept defaults for install.

After installing it is recommended to perform your Windows Updates.
Appendix C

Installation Configuration Files

The settings from the installation configuration wizard are saved in a configuration file. This MySQL server configuration file will have a different name depending on what operating system platform you are using. There is no configuration wizard for Linux, so you will have to edit the file manually to make changes.

my.ini configuration file (Windows)

my.ini file should be located in %ProgramFiles%\MySQL\MySQL Server 5.5\ (if you are running MySQL Workbench you can locate it via the home screen->Manage Server Instances->Select your instance->tab System Profile->Path to configuration file).

To modify the my.ini file, open it with a text editor and make any necessary changes. You can also modify the server configuration with MySQL Workbench.

my.cnf configuration file (Linux)

my.conf is located in either /etc or /etc/mysql
Appendix D

Collation Settings

UTF8 Default collation needs to be utf8_general_ci since all DTS tables are created using this collation. Make sure “collation_database”, “collation_server” and “collation_connection” system variables are all set to utf8_general_ci. This can be checked after database creation by running the following command in the SQL query window:

```
show variables like '%coll%';
```

When you are finished adding your information click Apply and a new window will open. This new window will inform you of all the changes that are about to take place. Click Apply Changes and the necessary SQL statements will execute to create your database.

At first you will not see your database listed. In order to see your database you must click the Refresh button (circular arrows) in the toolbar. When you do this your new database will be listed and ready to go.

Note: If you forget to set your default collation to utf8_general_ci, you can change it later by logging in as your DTS user and running the following SQL statement (assuming your database/schema name is DTS):

```
alter database DTS default character set UTF8 collate utf8_general_ci;
```
Appendix E

Linux Installation

For Linux users, MySQL is already included with many Linux distributions (but most likely not installed for Red Hat Enterprise Linux). You can check if MySQL is installed with the following command:

```
[root@key ~]# rpm -qa | grep -i mysql
mysqlclient15-5.0.91-1.ius.el5
php53-mysql-5.3.2-6.ius.el5
MySQL-client-community-5.1.47-1.rhel5
MySQL-server-community-5.1.47-1.rhel5
```

For detailed step by step instructions to install MySQL on Linux with Red Hat Enterprise Linux RPMs, please go to the following web site:

http://www.thegeekstuff.com/2008/07/howto-install-mysql-on-linux/

Post Installation on Linux

Having case insensitive table names in MySQL under Linux, the bad news is ... you cannot. The closest solution to this would be to set lower_case_table_names=1, which would make all your tables lowercase, no matter how you write them. We need to set this system variable before running kbccreate.

Since we are using InnoDB tables, you should set this variable to 1 on all platforms to force names to be converted to lowercase. Also set max_allowed_packet to maximum of 1GB to increase size of buffer between client and server.

Do the following after you install MySQL on Linux.

1) Stop mysql server
2) Locate your my.cnf file on your Linux system (most likely in /etc or /etc/mysql)

http://ronaldbradford.com/blog/how-do-i-identify-the-mysql-my-cnf-file-2010-03-09/
If you cannot find my.cnf and you just installed the RPMs, try this command

`ls -l /usr/share/mysql/my*.cnf`

These files should show up:
- `rw-r-xr-x 1 root root 4780 May  6 17:50 my-huge.cnf`
- `rw-r-xr-x 1 root root 20181 May  6 17:50 my-innodb-heavy-4G.cnf`
- `rw-r-xr-x 1 root root 4754 May  6 17:50 my-large.cnf`
- `rw-r-xr-x 1 root root 4765 May  6 17:50 my-medium.cnf`
- `rw-r-xr-x 1 root root 2403 May  6 17:50 my-small.cnf`

Take one of these example files, rename it to my.cnf and copy my.cnf to /etc

3) Edit my.cnf file and append the following under [mysqld]

```plaintext
[mysqld]
lower_case_table_names=1
default-storage-engine=InnoDB
max_allowed_packet=100M
character-set-server=utf8
collation-server=utf8_general_ci
```

4) Start mysql server again and open a SQL window. Execute the statement: show variables. Look for the row lower_case_table_names, max_allowed_packet and storage_engine to verify settings.

As for adding a dts user to a Linux MySQL database, you can create a remote server instance with MySQL Workbench (which you installed on your Windows PC), and then add a user with MySQL workbench for that Linux server instance. You will also need to give remote access to your MySQL server on Linux for root access to the database before you create a new remote server instance with MySQL Workbench. This link below has more details.

Create a remote server
Click on New Server Instance in your Home tab of MySQL Workbench (right side under Server Administration)

The Create New Server Instance Wizard Popup appears.
Fill in the IP address of your Linux server.

Click Next and complete the rest of the successive steps in the Wizard. I will skip the rest of the screenshots except for Host SSH Connection. You will need to enter ssh login information here.
For the wizard step that asked for your Operating System, select “Linux (Custom)” since we downloaded the community edition.)
Continue the rest of the wizard steps (not shown), when you reach the last page click Finish.

This following screenshot shows new entries named 172.26.1.160 (which refers to the Linux server) after configuration. Once configured, you can also start and stop the remote MySQL server from MySQL Workbench as well.
Double click your remote MySQL server (under Server Administration) and you can customize your configuration. Your changes will be saved to /etc/my.cnf file if you click “Apply...” button in the bottom right.

Verify that your default storage engine is InnoDB.
Click on Advanced Tab and verify that your table names are case insensitive.

Click on Networking Tab and verify that maximum packet size is 100M.
Check the character-set-server and collation-server settings under the Misc tab.

Check User accounts. Assuming you have created a user 'dts' make sure you can access it from any host. If the hostname is “%”, you should have remote access through port 3306 from anywhere.
You can now finish the configuration just like on Windows by creating new connections for root and dts accounts.